# Organizing Your Outlook 2007 Mailbox

## Table of Contents

**Use Your Mail to Take Action** .................................................................................................................. 2  
**Set Up a Meeting** .................................................................................................................................... 3  
**Create a Task** ......................................................................................................................................... 3  
**Create a Contact** ................................................................................................................................... 3  
**When the Action Is Extraction** ............................................................................................................... 4  

**Flag and Monitor Messages** ..................................................................................................................... 4  
**Prioritize with Follow Up Flags** ............................................................................................................. 5  
  - Flag outgoing messages .......................................................................................................................... 5  
  - View and respond to flagged messages ............................................................................................... 6  
**Keep Track of Messages with Flags and the To-Do Bar** ........................................................................... 6  
  - Meet the To-Do Bar ................................................................................................................................ 6  
  - Change the subject, but only in the To-Do Bar .................................................................................... 7  
  - When you complete, don’t delete ........................................................................................................ 7  
  - Show the To-Do Bar as you like it .......................................................................................................... 8  
**Flagged Messages Show Up in Many Places** ............................................................................................. 8  

**Organize With Colored Categories** ......................................................................................................... 8  
**Create a New Color Category** .................................................................................................................. 9  
  - Rename a color category ....................................................................................................................... 9  
**How to Assign a Category** ...................................................................................................................... 10  
**Can’t Remember What the Color Means?** ............................................................................................ 10  
**View Messages by Category** ................................................................................................................... 10  

**Store It** ..................................................................................................................................................... 11  
**How to Create a Folder** ............................................................................................................................ 11  
**Copy an Item to Another Folder** ............................................................................................................ 11  
  - Copy using drag and drop ..................................................................................................................... 12  
  - Copy using the Edit menu ...................................................................................................................... 12  
  - Copy using the clipboard .................................................................................................................... 12  
**Move Messages to a Folder** .................................................................................................................... 12  
  - Move messages by dragging ................................................................................................................ 12  
  - Move messages with a command ......................................................................................................... 13  
**Move or Copy a Folder** ............................................................................................................................ 13  

**Use Favorite Folders** .................................................................................................................................. 13  
**Add or Remove a Favorite Folder** .......................................................................................................... 14  

**Find Any Message, Fast** ........................................................................................................................... 14  
**Find it Fast with Instant Search** ............................................................................................................... 14  
**Advanced Search** .................................................................................................................................... 15  
**Clear a Search and See All of Your Messages Again** .............................................................................. 15  
**Narrow Your Search Criteria for Better Searches in Outlook** .................................................................. 15  
**Search Archives and Beyond** .................................................................................................................. 19  
**What About Other Outlook Items?** ......................................................................................................... 19

---

Organizing your Outlook 2007 Mailbox

Topics came directly from Microsoft Outlook 2007 Help.

ICT Training, Maxwell School of Syracuse University
While it's true that e-mail can make communication more efficient, it's also true that the volume of messages can get overwhelming quickly. And, too much e-mail can make you feel out of control. Without some means of organizing and filtering e-mail, most people would be inundated with messages, many of which are absolutely useless.

Outlook 2007 includes features to help you control e-mail volumes, find what you need, and act when and where action is required. Some of these features have been with Outlook all along, and some are new to this version. The good news is that all these features are flexible; so you'll be able to adapt them to fit your own organizational style.

Use your mail to take action

When you read a message in e-mail, that message often causes you to take some sort of action. Your action might be to respond right away with a reply, or to take some secondary action, such as setting up a meeting.

In order to clear away the clutter in your Inbox, think about a message as you read it and decide whether it requires action. If action is required, think about what you need to do. Should you respond right now? Later? Do you need to flag the message for follow-up, or create a task? Use Outlook to take action when and how you need to.

- Use a message as the starting point for a meeting, a task, or a contact In
  Microsoft Office Outlook 2007, you can use an e-mail message to start a calendar entry, add a contact, or create a task. This can save you time because the details from the message will be captured in the body of the new item. To get started, drag the message to the appropriate button in the Navigation Pane.
Organizing your Outlook 2007 Mailbox

Topics came directly from Microsoft Outlook 2007 Help.

ICT Training, Maxwell School of Syracuse University

Page 3

Set up a meeting

If a message makes you realize that you need to meet with someone, here’s a quick way to get started:

1. Drag the message to the Calendar button on the Navigation Pane.
2. A new appointment opens. Click the “Invite Attendees” button on the Ribbon, and fill in the rest of the details (such as the date, time, and location).
3. Invite the person to the meeting by clicking Send.

Create a task

In the picture, the message from Ben Smith in Mark Lee's Inbox reminds Mark that he needs to promote a line of office furniture that his company recently introduced.

Mark can drag the message from his Inbox to the Tasks button in the Navigation Pane to quickly start a new task. He can change the subject to something more task-like, for example Show office furniture to Coho, and then save the task. The task is added to Mark's task list.

Create a contact

If you're keeping a message around so that you'll have a contact's e-mail address handy, a better idea is to create a contact entry in Contacts.

As in the picture, you can drag a message to Contacts to get the contact entry started. When you drag a message to the Contacts button, a new Contact form opens and the e-mail address in the message is automatically added to it.

From there you can fill in the rest of the details, such as a street address, telephone number, and so on. The next time you need to look up a bit of information about that contact, you'll know right where to look: in Contacts.
When the action is extraction

Suppose you receive a message with an attachment, and all you really want is the attachment. You can save the attachment to your hard disk independent of the message. That is, you can "extract" it from the message. Also, new to Outlook 2007 is the ability to preview attached files right from the Reading Pane. (The attachment must appear in the attach field (the field below the Subject line), not within the body of the message.) Being able to preview a file this way may save you some time.

Once you've saved the attachment, you may no longer need the message. If this is the case, you can delete it or file it away. Another message out of your Inbox.

- **To extract an attachment in the Reading Pane**, right-click the attachment and use the Save As command.
  - (If you don't have the Reading Pane turned on, point to Reading Pane on the View menu and then click Right.)

- **To use the quick preview feature** to look at an attachment before you decide whether you want to save it, click the attachment.

Warning received after clicking once on the Excel file attachment.

```
You should only preview files from a trustworthy source.
Previewing the file might not show the full content of the file.
The file.
```

Preview of Excel file in the message section of the Reading Pane.

- Click the Message button to get back to the message.

Flag and monitor messages

Outlook 2007 allows you to flag a message to draw your attention to the message and display an optional reminder when the follow-up action is due. The flag appears in the message header.

You can choose from one of five predefined flags or choose a custom flag. The predefined flags have date specifications of Today, Tomorrow, This Week, Next Week, and No Date. If you choose the custom flag option, you can specify any date you want. The predefined dates give you a quick and easy way to assign a general follow-up date, while the custom option lets you specify a specific date.
You can flag messages that you’ve received from others, as well as those you’ve sent. This capability gives you a way to flag and follow up messages from your end. You can flag messages in any message folder, including the Sent Items folder.

**Prioritize with follow up flags**

An easy way to keep track of what you need to do, based on the information in a message, is to simply flag the message for follow-up. When you flag a message, you’ll remember to attend to it — even if the message starts to sink to the bottom of your Inbox.

In the picture, a message in the Inbox that has been flagged with a follow-up flag. Notice that the flagged message also appears in the To-Do Bar.

1) Right-click in the **Flag Status** column next to the message that you want to flag, and select a flag type (for example, click **Today** to give it a Today follow-up flag).

2) Look at your To-Do Bar and notice that the message now shows up there. (If you have other tasks in the To-Do Bar, you may need to scroll to see it.)

**Tip:** Another quick way to attach a flag to a message is to drag the message directly to the To-Do Bar.

**Flag outgoing messages**

With Outlook 2007, you can flag outgoing messages for follow-up for yourself, the recipient, or both. So, the capability to flag an outgoing message lets you set a reminder on the message to follow up on the message yourself. For example, you might send an e-mail message to a coworker asking for information about a project. The follow-up flag could remind you in a week to follow up if you haven’t had a response. You can also flag a message to generate a reminder on the recipient’s computer.

Use the following steps to flag a message you send:

1) With the message form open prior to sending the message, on the **Message** tab on the Ribbon, in the **Options Group**, click **Follow Up**, and then click **Add Reminder** to open the **Custom** dialog box.

2) In the **Flag To** drop-down list, select the text you want to include with the flag, or type your own text in this box.

3) If you want to include a due date and a subsequent reminder, select the date in the **Due Date** drop-down list, which opens a calendar that you can use to select a date. Alternatively, you can enter a date, day, time, or other information as text in the **Due Date** box.

4) Click **OK**, and then send the message as you normally would.
Follow these steps to flag a message for follow-up on the recipient’s computer:

1) Open a new message form, and then click **Follow Up** in the **Options** group on the **Message** tab.
2) Choose **Flag For Recipients** to open the **Custom** dialog box.
3) Verify that the **Flag For Recipients** option is checked, and then select the follow-up action in the **Flag To** drop-down list.
4) Specify a reminder, and then click **OK**.
5) Complete the message, and then send it.

**View and respond to flagged messages**
A flag icon appears next to the message header for flagged messages in the message folder. If you have configured Outlook 2007 to display the Reading Pane, the flag text appears in the InfoBar. The flag icons also help you to identify flagged messages regardless of whether the Reading Pane is displayed. You can sort the view in the folder using the Flag column, listing all flagged messages together to make them easier to locate. To view the flag text when the Reading Pane is turned off, simply open the message. The flag text appears in the message form’s InfoBar.

Outlook 2007 has no special mechanism for processing flagged messages other than the reminders previously discussed. You simply call, e-mail, or otherwise respond based on the flag message. To change the flag status, simply click the flag, or right-click a flagged message and then choose **Flag Complete**. To remove the flag from the message, right-click a flagged message, and then choose **Clear Flag**.

**Keep track of messages with flags and the To-Do Bar**
Something new to Outlook 2007 is the To-Do Bar. It’s there to help you keep track of what you need to do.

In the To-Do Bar, you’ll see upcoming items from your calendar as well as flagged messages and tasks.

**Meet the To-Do Bar**

The **To-Do Bar** displays flagged messages, tasks from your **Tasks** folder, and upcoming meetings, appointments, and events from your calendar. In the To-Do Bar, you can see these things at a glance, without having to switch to other windows in Outlook.

1. **Date Navigator**
2. Upcoming calendar appointments
3. A place to enter new tasks by typing
4. Your task list (flagged messages and tasks)
Change the subject, but only in the To-Do Bar

Because the subject of a message doesn't always describe the task that you need to do, you can change the subject of a flagged message in the To-Do Bar. When you do this, the subject of the message in the Inbox is unchanged.

Click to select the text of the item in the To-Do Bar and type the new subject.

What's the difference between a flagged message and a task created by dragging to the Tasks button? The answer is that it's mostly a matter of style.

- If you like to delete messages after you've finished with them, you'll probably prefer to use Tasks to keep track of things you need to do. (When you drag a message to the Tasks button, you create a new item, so deleting the message doesn't affect the task.)
- If you like to *keep* your messages (either in your Inbox or in folders), you'll probably prefer to use follow-up flags because flagging is quick and easy.

When you complete, don't delete

You may be tempted to delete items from the To-Do Bar when you've completed them. However, there's a better way. When you complete a task, mark it as complete using the *Mark Complete* command. (A quick way to do this is to simply click the flag next to the item.) Completed items will drop off of your list as you might expect.

But what's really helpful about marking an item as complete is that you'll see it listed on your calendar at the bottom of the day on which you completed it. And it'll be crossed out so that you'll know you've completed it.

It's a great way to remind yourself of all of the work that you've done.

In the To-Do Bar and in the Calendar, any task not marked as complete on its due date will automatically be carried over to the following day until you complete it.

**Caution:** If you choose to *delete* an item from the To-Do Bar, the flagged message will also be deleted from your Inbox. Similarly, if you delete the flagged message from the Inbox, you'll also delete it from the To-Do Bar. *Mark Complete* is safer.
Show the To-Do Bar as you like it

- To change what's shown in the To-Do Bar, click To-Do Bar on the View menu, and select or clear the items you want to show or hide. (Or, click Options to customize all To-Do Bar options at once.)
- To hide it, simply press ALT+F2 or click the Close button.

  o Show it again by pressing ALT+F2 or by clicking the To-Do Bar submenu on the View menu.

- A quick way to make more room for other windows in Outlook (like the Reading Pane): Minimize the To-Do Bar by clicking the Minimize the To-Do Bar arrow next to its title.

Flagged messages show up in many places

Messages that you flag for follow-up not only show up in the To-Do Bar, they also show up in your task list and on your calendar. That's to help you remember to do the things on your list. And, if that's not enough, you can set reminders for them so that you actually remember to follow up.

Here are some things to remember about flagged messages and the To-Do Bar:

- In the To-Do Bar, you can change the subject of the flagged message without affecting the subject that appears in the Inbox. To do this, click to select the text of the item in the To-Do Bar and type the new subject.
- When you've completed an item, use the Mark Complete command.
- Flagged messages show up in the To-Do Bar, on your Calendar, and in Tasks. (And, remember that deleting a flagged message will delete it from your Inbox, from the To-Do Bar, and from the Calendar).
- You can drag items to the Date Navigator in the To-Do Bar to quickly set up an appointment for the day that you drag to.
- Press ALT+F2 to minimize, show, or hide the To-Do Bar.
  o Use the Minimize the To-Do Bar button to keep it visible, but smaller.
- To change what's shown in the To-Do Bar, click To-Do Bar on the View menu, and select or clear the items you want to show or hide. (Or, click Options to customize all To-Do Bar options at once.)

Organize with colored categories

Color categories allow you to easily identify and group associated items in Microsoft Office Outlook. Assign a color category (a keyword or phrase with an associated color that helps you keep track of items, such as messages, contacts, and appointments. You can use color categories to easily find, sort, filter, or group items.) to a group of interrelated items — such as notes, contacts, appointments, and e-mail messages — so that you can quickly track and organize them. You can also assign more than one color category to items.

The category colors are prominently displayed in table views, such as your Inbox, and within the open items themselves. You can rename the categories to something more meaningful to you or choose different colors for the categories. This flexibility enables you to design a color category system that fits your personal work style.
A Categorized Mail search folder has been added to Search Folders in the Navigation Pane and provides a view of all your categorized mail items. Within this folder, you can sort and group the categorized items.

If you are working on a special project, you can make messages about the project easier to find later by marking all the related messages with a color-coded category. In the picture, notice some color-coded messages:

- Green is for messages about Coho Winery and yellow is for messages about Contoso.
- Notice that a message can be color coded with multiple colors if it applies to more than one account, as the selected message does.
- You'll also see colored categories and their names in the Reading Pane.

If you used colored flags in Outlook 2003, you'll find that Outlook 2007 improves on this concept by allowing you to use names along with the colors.

If a message belongs in more than one category, that's okay. There's no limit to the number of categories that you assign to a message.

Create a new color category

1) On the toolbar, click **Categorize**.
2) Click **All Categories**.
3) Click **New**.
4) The **Add New Category** dialog box opens.

5) In the **Name** box, type a name for the new color category.
6) Click the arrow next to **Color**, click the color that you want, and then click **OK**.
   a) Choosing a shortcut key is optional.

Rename a color category

The existing color categories have generic names, such as Red Category and Blue Category. To easily identify and organize your categorized items, you can rename the color categories by using names that are meaningful to you.

1) On the toolbar, click **Categorize**.
2) Click **All Categories**.
3) In the **Name** list, click the name of a color category, and then click **Rename**.
4) In the **Name** list, type the new name for the color category.
How to assign a category

You create each category name and choose the color that's associated with it. Then, you can assign that category to incoming and existing messages. One way to assign a color category to a message is to right-click in the Categories column and use the shortcut menu, as shown in the picture.

Once you've assigned a category to a message, you can quickly scan your Inbox and find the message just by looking for its colored tag.

Tip: Unless you're adapting an existing system that's already working for you, it's probably best to stick to just a few categories. Keeping the system simple will make it easier to use.

Can't remember what the color means?

It happens to the best of us. We come up with a great system for keeping ourselves organized, and then poof, we forget one part of the system. Say, for example, that you used orange to color code all personal messages. Then, suppose you don't get a personal message for a while, and you forget what orange means. No problem. The decoder is a just a click away.

To see a list of categories and their associated colors, click the Categorize button on the Standard toolbar.

Note: You can also right-click the color next to a message to see the name of the category associated with that color.

View messages by category

Now, let's suppose you've color coded all of your messages according to the projects you're working on or the clients you work with. How can you view them in these groups? That's easy: Right-click a column heading to see the Arranged By shortcut menu and then click Categories. Note that in the picture, messages were switched from arranging by date to arranging them by their categories: Blue Yonder Airlines, Coho Winery, and Contoso.
Store it

Do you like an empty Inbox? One easy method for clearing away clutter is to create custom folders and then move messages out of your Inbox and into these folders. With folders, you choose the names, so how messages are organized will make sense to you.

What if you want to sort messages into distinct groups and keep them separate from other messages (and thereby get them out of your Inbox)? Folders can help you do this.

You may already use a filing system in your office. Once you learn how to create folders, you can easily adapt any existing folder-naming system to Outlook.

**How to create a folder**

1) In the Navigation Pane, right-click your mailbox and click New Folder. (Or, point to New on the File menu and click New Folder.)

2) In the Create New Folder dialog box, type a name for the folder in the Name box.

3) Verify that Mail and Post items is selected under Folder contains, and select a location for the folder.

4) To have the folder appear as a top level folder in your mailbox (at the same level as your Inbox), select Mailbox.

5) Click OK.

**Copy an item to another folder**

When you copy a message, the message remains in the original folder and a duplicate is saved in the destination folder.

To copy multiple messages, do the following first:

- To select adjacent messages, click the first message, and then hold down SHIFT and click the last message. All messages in the list between the first and last message you clicked are selected.
- To select nonadjacent messages, click the first message, and then hold down CTRL and click additional items.
**Copy using drag and drop**

1) Select the item you want to move.
2) The default action when you use drag-and-drop is to move the folder and all of its contents. If you want to copy the folder, press and hold **Ctrl** while dragging and until you release the mouse button.

**Another drag and drop method:**

1) Right-drag to the destination folder, and then release the mouse button.
2) Choose **Copy** from the menu.

**Note:** If the destination is within a collapsed folder, hover over the plus symbol and the folder will expand to show the subfolders. Repeat this as necessary until the folder you want appears.

**Copy using the Edit menu**

1) Select the item you want to move.
2) On the **Edit** menu, click **Copy to Folder**.
3) In the **Copy Items** dialog box, click the folder where you want a copy of the message saved, and then click **OK**.

**Note:** If you want to create a new folder, in the **Copy Items** dialog box click **New**.

**Copy using the clipboard**

1) Select the item you want to move.
2) On the **Edit** menu, click **Copy**.
3) Navigate to the folder where you want to save the copy, and then on the **Edit** menu, click **Paste**.

**Move messages to a folder:**

1) Right-click the message or group of messages, and then click **Move to Folder**.
2) In the **Move Items** dialog box, select the desired destination folder, and click **OK**.
   a) You'll see a dialog box informing you that the action will apply to all of the items in the selected groups — which is exactly what you want.
3) Click **OK**.

**Move messages by dragging**

An easy way to move a single message (or group of messages) to a folder is to drag it from the list of messages to the folder in the Navigation Pane.

1) Select a message, or group of messages.
2) Point to one of the highlighted messages and drag them to the desired folder in the navigation pane
3) When the folder you want to place the messages into is highlighted, let go of your mouse.
Move messages with a command

The dragging method just mentioned is fast. However, it has a down side: There's a chance that you'll accidentally "drop" the messages in the wrong location. A safer method is to right-click the message or messages you want to move and then click Move to Folder.

1. Right-click a message.
2. Click Move to Folder.
3. Select the folder name from the list of folders in the Move Items dialog box and click OK.

This is an especially good choice when you want to move a *collection* of messages. For example, if you're viewing messages in a certain arrangement, say by category, use this method to move all of the messages in that category to a folder by dragging the category heading.

Move or copy a folder

1. Right-click the folder you want to move or copy.
   
   **Note:** Unlike folders in Microsoft Windows Explorer, you can only select one Outlook folder at a time. To move more than one folder, you need to repeat the steps for each folder.

2. Click Move folder name or Copy folder name.
3. Click the folder where you want to copy or move the selected folder, and then click OK.

Use Favorite Folders

Once you start filing your e-mail messages in folders, you'll notice that some folders get used more frequently than others. To make finding and filing go faster, move those frequently used folders to Favorite Folders.

**Note:** The folders stay in their original locations in your mailbox. The Favorite Folders area simply provides a quick and easy way for you to access them.

When a favorite folder falls out of favor, you can remove it from the Favorite Folders area of the Navigation Pane. Don't worry, the folder will remain in your mailbox — it just won't be displayed in the Favorite Folders area of the Navigation Pane anymore.
Add or remove a favorite folder

1) In the Navigation Pane, under Mail Folders, select the folder that you want to make a favorite and drag it up to the Favorite Folders area.

2) To remove a folder from the Favorite Folders area of the Navigation Pane, right-click it and click Remove from Favorite Folders.

Caution: Don't use the Delete command to remove a folder from Favorites. That will delete the folder and its contents completely.

Find any message, fast

Let's face it. No matter how organized you are, whether you organize everything in folders or love to color code, the time will come when you just can't find that important message.

Luckily, searching for messages in Office Outlook 2007 is not only easy, but it's fast. And now you can search for messages that are in different locations, including archives or multiple mailboxes. No matter where you store your messages, Search can help.

Find it fast with Instant Search

With the new Instant Search, you'll not only find messages faster than previous versions of Outlook, you'll also be able to quickly and easily fine-tune your search results: Add more words to your query and you'll see the search results narrow, instantly.

Outlook now also makes it easy for you to see why a certain message appears in the search results: The words or terms that made a particular message a match are highlighted. You can see this in the picture, which shows the results of a search for messages containing the words "quarterly sales."

1) **To find messages**, type the search criteria in the **Instant Search** box located at the top of your message list.

2) Hit your **Enter** key.
Advanced search

Typing in the **Instant Search** pane brings up search results based on any matching words in a message. If you want to search on specific parts of a message — for example, if you want to search based on who a message is from, you'll need to use advanced search terms. Search criteria can be found beginning on page 16.

1. Click the **Expand** button (as shown in the picture) and, type the advanced criteria.
2. You'll notice that as you do this the words in the **Instant Search** box are updated to show the new criteria.

Clear a search and see all of your messages again

When you search, the search results appear in the main Outlook window. They will remain there until you tell Outlook what to do next — say, perform another search or return to your Inbox.

You'll always know that you're looking at search results if the **Instant Search** pane is active. You can tell if the pane is active if it's a different color from the surrounding panes and you see the words **(Search Results)** after the folder name at the top of the pane.

To restore all of the messages in the current folder, click the **Clear Search** button.

**Tip:** You also can clear a search by clicking a folder in the Navigation Pane (for example, click **Inbox** in the Navigation Pane to restore the view in which you can see all of the messages in your Inbox).

Narrow your search criteria for better searches in Outlook

Use the **Instant Search** pane to enter advanced search criteria, or type criteria directly in the **Instant Search** box. For example, type **From: John Kane** to find messages in which John Kane's name is in the **From** box.

The following table shows examples of searches you might find useful. The search query syntax, available when the **Instant Search** feature is enabled, follows this basic form: `keyword:your search criteria value`.

For example, **from:bobby**

You can also use logical operators AND, NOT, OR, <, >, =, and so forth to refine your search, and these are noted in the table. Logical operators must be typed in uppercase letters.
<table>
<thead>
<tr>
<th>Type this</th>
<th>To find this</th>
</tr>
</thead>
<tbody>
<tr>
<td>bobby</td>
<td>Items containing <em>bobby</em>, <em>BOBBY</em>, <em>BoBby</em>, or any other combination of uppercase and lowercase letters. Instant Search is not case sensitive.</td>
</tr>
<tr>
<td>bobby moore</td>
<td>Items containing both <em>bobby</em> and <em>moore</em>, but not necessarily in that order.</td>
</tr>
<tr>
<td>bobby AND moore</td>
<td>Items containing both <em>bobby</em> and <em>moore</em>, but not necessarily in that order. Note that logical operators such as AND, NOT, and OR must be in uppercase letters.</td>
</tr>
<tr>
<td>bobby NOT moore</td>
<td>Items containing <em>bobby</em>, but not <em>moore</em>.</td>
</tr>
<tr>
<td>bobby OR moore</td>
<td>Items containing <em>bobby</em>, <em>moore</em>, or both.</td>
</tr>
<tr>
<td>&quot;bobby moore&quot;</td>
<td>Items containing the exact phrase <em>bobby moore</em>. Note the use of double quotes so that the search results match the exact phrase within the quotes.</td>
</tr>
<tr>
<td>from:&quot;bobby moore&quot;</td>
<td>Items sent from <em>bobby moore</em>. Note the use of double quotes so that the search results match the exact phrase within the quotes.</td>
</tr>
<tr>
<td>from:&quot;bobby moore&quot; about:&quot;status report&quot;</td>
<td>Items sent from <em>bobby moore</em> where <em>status report</em> appears in the subject line, body, and attachment contents. Note the use of double quotes so that the search results match the exact phrase within the quotes.</td>
</tr>
<tr>
<td>hasattachment:yes</td>
<td>Items that have attachments. You can also use hasattachment:true to get the same results.</td>
</tr>
<tr>
<td>attachments:presentation.pptx</td>
<td>Items that have attachments named <em>presentation.pptx</em> or if the attachment contains <em>presentation.pptx</em> within its contents.</td>
</tr>
<tr>
<td>subject:&quot;bobby moore&quot;</td>
<td>Items whose subject contains the phrase <em>bobby moore</em>.</td>
</tr>
<tr>
<td>subject:bobby moore</td>
<td>Items with <em>bobby</em> in the subject line and with <em>moore</em> anywhere else in the document.</td>
</tr>
<tr>
<td>cc:&quot;bobby more&quot;</td>
<td>Items in which the display name <em>bobby moore</em> is on the Cc line.</td>
</tr>
<tr>
<td>cc:<a href="mailto:bobbymoore@contoso.com">bobbymoore@contoso.com</a></td>
<td>Items in which the e-mail address <em><a href="mailto:bobbymoore@contoso.com">bobbymoore@contoso.com</a></em> is on the Cc line.</td>
</tr>
<tr>
<td>bcc:bobby</td>
<td>Items in which <em>bobby</em> is on the Bcc line.</td>
</tr>
<tr>
<td>messagesize:&lt;10 KB</td>
<td>Items whose size is less than 10 kilobytes. Note the use of the &quot;less than&quot; comparison operator (&lt;).</td>
</tr>
<tr>
<td>messagesize:&gt;5 MB</td>
<td>Items whose size is larger than 5 megabytes. Note the use of the &quot;greater than&quot; comparison operator (&gt;).</td>
</tr>
<tr>
<td>received:=1/1/2009</td>
<td>Items that arrived on 1/1/2009. Note the use of the &quot;equals&quot; comparison operator (=).</td>
</tr>
<tr>
<td>Type this</td>
<td>To find this</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>received:yesterday</td>
<td>Items that arrived yesterday. Instant Search also recognizes the follow date values:</td>
</tr>
<tr>
<td></td>
<td><strong>Relative dates</strong>: For example, <em>today</em>, <em>tomorrow</em>, <em>yesterday</em></td>
</tr>
<tr>
<td></td>
<td><strong>Multi-word relative dates</strong>: For example, <em>this week</em>, <em>next month</em>, <em>last week</em>, <em>past month</em>, <em>coming year</em></td>
</tr>
<tr>
<td></td>
<td><strong>Days</strong>: <em>Sunday</em>, <em>Monday</em> ... <em>Saturday</em></td>
</tr>
<tr>
<td></td>
<td><strong>Months</strong>: <em>January</em>, <em>February</em> ... <em>December</em></td>
</tr>
<tr>
<td>received:last week</td>
<td>Items that arrived last week. Note that if you run this query again a month from now you will obtain different results because it is a time relative query.</td>
</tr>
<tr>
<td>due:last week</td>
<td>Items that are flagged for follow up on a due date.</td>
</tr>
<tr>
<td>messagesize:tiny</td>
<td>Items whose size is less than 10 kilobytes</td>
</tr>
<tr>
<td>messagesize:small</td>
<td>Items whose size is between 10 and 25 kilobytes</td>
</tr>
<tr>
<td>messagesize:medium</td>
<td>Items whose size is between 25 and 100 kilobytes</td>
</tr>
<tr>
<td>messagesize:large</td>
<td>Items whose size is between 100 and 500 kilobytes</td>
</tr>
<tr>
<td>messagesize:verylarge</td>
<td>Items whose size is between 500 kilobytes and 1 megabyte</td>
</tr>
<tr>
<td>followupflag:follow up</td>
<td>Items that are flagged for follow up.</td>
</tr>
<tr>
<td>messagesize:enormous</td>
<td>Items whose size is larger than 5 megabytes</td>
</tr>
<tr>
<td>hasflag:true</td>
<td>Items that are flagged for follow up.</td>
</tr>
<tr>
<td>from:bobby (received:1/7/05 OR received:1/8/05)</td>
<td>Items from <em>bobby</em> that arrived on either 1/7/05 or 1/8/05. Note the use of parentheses to group the dates.</td>
</tr>
<tr>
<td>received:&gt;=10/1/06 AND received:&lt;10/5/06</td>
<td>Items that arrived between 10/1/06 and 10/5/06.</td>
</tr>
<tr>
<td>received:&gt;10/1/06 AND received:&lt;10/5/06</td>
<td>Items that arrived after 10/1/06 but before 10/5/06.</td>
</tr>
<tr>
<td>sent: yesterday</td>
<td>Items that you sent yesterday.</td>
</tr>
<tr>
<td>to:bobby</td>
<td>Items that you sent to <em>bobby</em> when you are searching in the Sent Items folder.</td>
</tr>
<tr>
<td>read:no</td>
<td>Items that have not been read. You can also use read:false to get the same results.</td>
</tr>
<tr>
<td>subject:status received:May</td>
<td>Items received from anyone during the month of May (any year) where the subject contains <em>status</em>.</td>
</tr>
<tr>
<td>startdate:next week subject:status</td>
<td>Calendar items next week where the subject contains <em>status</em>.</td>
</tr>
<tr>
<td>is:recurring</td>
<td>Calendar items that are recurring.</td>
</tr>
<tr>
<td>organizer:bobby</td>
<td>Calendar items where <em>bobby</em> is the organizer.</td>
</tr>
<tr>
<td><strong>Type this</strong></td>
<td><strong>To find this</strong></td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>category:business</td>
<td>Items that are categorized as <em>business</em>.</td>
</tr>
<tr>
<td>firstname:bobby</td>
<td>Contacts that contain <em>bobby</em> in the First Name field.</td>
</tr>
<tr>
<td>lastname:moore</td>
<td>Contacts that contain <em>moore</em> in the Last Name field.</td>
</tr>
<tr>
<td>nickname:bobby</td>
<td>Contacts that contain <em>bobby</em> in the Nickname field.</td>
</tr>
<tr>
<td>jobtitle:physician</td>
<td>Contacts that contain <em>physician</em> in the Job Title field.</td>
</tr>
<tr>
<td>pager:555-0100</td>
<td>Contacts that contain <em>555-0100</em> in the Pager field.</td>
</tr>
<tr>
<td>businessphone:555-0100</td>
<td>Contacts that contain <em>555-0100</em> in the Business Phone field.</td>
</tr>
<tr>
<td>homephone:555-0100</td>
<td>Contacts that contain <em>555-0100</em> in the Home Phone field.</td>
</tr>
<tr>
<td>mobilephone:555-0100</td>
<td>Contacts that contain <em>555-0100</em> in the Mobile Phone field.</td>
</tr>
<tr>
<td>carphone:555-0100</td>
<td>Contacts that contain <em>555-0100</em> in the Car Phone field.</td>
</tr>
<tr>
<td>businessfax:555-0100</td>
<td>Contacts that contain <em>555-0100</em> in the Business Fax field.</td>
</tr>
<tr>
<td>homefax:555-0100</td>
<td>Contacts that contain <em>555-0100</em> in the Home Fax field.</td>
</tr>
<tr>
<td>businessaddress:(4567 Main St., Buffalo, NY 98052)</td>
<td>Contacts that contain <em>4567 Main St., Buffalo, NY 98052</em> in the Business Address field. Note the use of parentheses to enclose the address.</td>
</tr>
<tr>
<td>homeaddress:(4567 Main St., Buffalo, NY 98052)</td>
<td>Contacts that contain <em>4567 Main St., Buffalo, NY 98052</em> in the Home Address field. Note the use of parentheses to enclose the address.</td>
</tr>
<tr>
<td>businesscity:buffalo</td>
<td>Contacts that contain <em>buffalo</em> in the Business City field.</td>
</tr>
<tr>
<td>businesspostalcode:98052</td>
<td>Contacts that contain <em>98052</em> in the Business Postal Code field.</td>
</tr>
<tr>
<td>street:(4567 Main St)</td>
<td>Contacts that contain <em>4567 Main St</em> in the Business Address Street field. Note the use of parentheses to enclose the address.</td>
</tr>
<tr>
<td>homestreet:(4567 Main St)</td>
<td>Contacts that contain <em>4567 Main St</em> in the Home Address Street field. Note the use of parentheses to enclose the address.</td>
</tr>
<tr>
<td>webpage:www.contoso.com</td>
<td>Contacts that contain the URL <em><a href="http://www.contoso.com">www.contoso.com</a></em> in the Web Page Address field.</td>
</tr>
</tbody>
</table>

Type this To find this
Search archives and beyond
Search multiple locations by clicking All Mail Items at the top of the All Mail Folders area of the Navigation Pane

New to Outlook 2007 is the ability to search multiple locations at one time. For example, you can search Archive folders and your Microsoft Exchange Server mailbox at the same time.

How? Select All Mail Items as the location for your search. All Mail Items also appears at the top of the Instant Search pane so that you can clearly see what's being searched.

Note: In order to search for messages in an Outlook storage folder (also known as a Personal Folders file (PST)), that folder must be open in Outlook. Here are the steps required to do that:

1) On the File menu, point to Open, and then click Outlook Data File.
2) Click the .pst file you want to open, and then click OK.
   a) The name of the folder associated with the data file appears in the Folder List. To view the Folder List, on the Go menu, click Folder List. By default, the folder will be called Personal Folders.

What about other Outlook items?

If you want to search your Inbox, Calendar, and Tasks all at once, you can. To do this, you would first switch to the Folder List (click Folder List in the Navigation Pane) and use the Instant Search pane there.

Otherwise, searching is restricted to one type of Outlook item at a time. For example, you can search for messages or you can search for items in your Calendar.

Organize messages into pre-defined groups
Try using arrangements to organize your Inbox. An arrangement is a predefined grouping and sorting order for messages. For example, you can arrange your messages by conversation so that they are grouped by message subject or "thread." The threads are sorted by date, and the messages within each thread are sorted based on who replied to whom and when.

Microsoft Office Outlook provides 14 predefined, standard arrangements that you can choose from. They are available from the View menu.

The default arrangement that is used to view messages is the Date arrangement. When you choose an arrangement and view it, the groups of messages are fully expanded by default, with the exception of the Conversation arrangement, in which the groups are collapsed by default.
Although you cannot create a custom arrangement, you can create a custom view with customized grouping and sorting. However, this customizing can be done only in a table view type (a view type that displays a list of items (rows) and their attributes (columns). Use this view to display details about items. Table is the default view type for Inbox and Tasks.).

**Change the arrangement in your Inbox**

- On the View menu, click Arrange By, and then click the arrangement that you want.

**Descriptions of the 14 predefined arrangements**

The following is a list of descriptions of the predefined arrangements.

<table>
<thead>
<tr>
<th>Arrangement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments</td>
<td>Groups messages into two groups (With Attachments and No Attachments) and sorts by the received date.</td>
</tr>
<tr>
<td>Categories</td>
<td>Groups messages by categories and sorts by the received date.</td>
</tr>
<tr>
<td>Conversation</td>
<td>Groups messages by message subject or thread. The sorting order of items in the threads is based on who replied to whom, and the sorting order of the groups is by date. When a new message is received, the entire conversation that it is a part of moves to the top of the message list. By default, only unread and flagged messages are displayed. You can see all messages in the conversation by clicking the arrow next to the conversation heading. To help you keep track of the conversation or e-mail message thread, messages are indented to show who replied to whom and when they replied.</td>
</tr>
<tr>
<td>Date</td>
<td>Groups and sorts messages by date. This is the default arrangement, and your view is simplified by hiding unnecessary details. For example, messages received today show the time only. Messages from yesterday show the day and time, and messages that are older than a week show you more detailed date information.</td>
</tr>
<tr>
<td>E-mail Account</td>
<td>Groups messages by e-mail accounts and sorts by the received date.</td>
</tr>
<tr>
<td>Flag: Due Date</td>
<td>Groups messages by flag and sorts by the due date that is assigned to the flag.</td>
</tr>
<tr>
<td>Flag: Start Date</td>
<td>Groups messages by flag and sorts by the start date that is assigned to the flag.</td>
</tr>
<tr>
<td><strong>Folder</strong></td>
<td>Groups messages alphabetically by folder names and sorts by the received date. This arrangement is available only in a Search folder.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>From</strong></td>
<td>Groups messages by names on the From line and sorts by the received date.</td>
</tr>
<tr>
<td><strong>Importance</strong></td>
<td>Groups messages by Importance (High, Normal, and Low) and sorts by the received date.</td>
</tr>
</tbody>
</table>
| **Size** | Groups messages into the following seven categories and then sorts the messages by size:  
  - Enormous (> 5 MB)  
  - Huge (1-5 MB)  
  - Large (100 - 500 KB)  
  - Medium (25-100 KB)  
  - Small (10-25 KB)  
  - Tiny (< 10 KB)  
  - Very Large (500 KB - 1 MB) |
| **Subject** | Groups messages alphabetically by subject and sorts them by the received date. |
| **To** | Groups messages by the name on the To line and sorts them by the received date. |
| **Type** | Groups messages by item type and sorts by received date. For example, all e-mail messages are in one group, meeting requests are in another, and task requests in a third. |

**Group or ungroup messages in your Inbox**

Microsoft Office Outlook automatically groups items by date. However, you can also group items manually by using standard arrangements (a predefined combination of grouped and sorted messages in table view) or by creating your own custom grouping. While you may be most familiar with the default groups (a set of items with one common attribute; for example, priority or status.) in your Inbox, these groups are also applied to other mail folders.

The default groups that are displayed in your Inbox include Today, Yesterday, Last Week, Last Month, and Older. Some of the standard arrangements that are available include grouping according to Categories, Size, Subject, and Importance.

You can also disable this feature if you choose.

**Group or ungroup items automatically**

- To quickly add or remove grouping in an arrangement, on the View menu, point to Arrange By, and then click Show in Groups.
**Group items manually or create a custom group**

1. On the **View** menu, point to **Arrange By**, and then click **Custom**.
2. Click **Group By**…
   a. Clear the **Automatically group according to arrangement** check box.
   b. In the **Group items by** box, click a field to group by.
      - If the field that you want is not in the **Group items by** box, click a different field set in the **Select available fields from** box.
   c. Click **Ascending** or **Descending** for the sort order of the group headings.
   d. To display the field that you are grouping items by, select the **Show field in view** check box.
   e. To group by subgroups, click a field in the **Then by** box.
   f. In the **Expand/collapse defaults** list, click the default for how you want groups to display in the view.
   g. Click **OK** to exit all dialog boxes.
3. After closing the dialog box, display or hide items in a group by clicking **Expand** or **Collapse**.

**Ungroup items manually**

1. On the **View** menu, point to **Arrange By**, and then click **Custom**.
2. Click **Group By**.
   a. In the **Group items by** box, click **none**.

**Disable the Grouping feature**

1. On the **View** menu, point to **Arrange By**, and then click **Show in Groups**.
   a. If **Show in Groups** is checked, the feature is on.
   b. If **Show in Groups** is not checked, the feature is disabled.

**Find and organize messages with Search Folders**

The Outlook 2007 search folders are an extremely useful feature for finding and organizing messages. A search folder isn’t really a folder but rather a special view that functions much like a separate folder. In effect, a search folder is a saved search. You specify conditions for the folder, such as all messages from a specific sender or all messages received in the last day, and Outlook 2007 displays in that search folder view those messages that meet the specified conditions.

In a way, a search folder is like a rule that moves messages to a special folder. However, although the messages seem to exist in the search folder, they continue to reside in their respective folders. For example, a search folder might show all messages in the Inbox and Sent Items folders that were sent by Jim Boyce. Even though these messages appear in the Jim Boyce search folder (for example), they are actually still located in the Inbox and Sent Items folders.

**Customize Search Folders**

Outlook 2007 includes five search folders by default, which you can use as is or customize to suit your needs:

- **Categorized Mail**: This search folder shows all messages that have categories assigned to them.
- **Fax**: If you are connected to a Microsoft Exchange Server 2007 mailbox with unified messaging enabled, this search folder will enable you to see all received faxes in your mailbox.
- **Large Mail**: This search folder shows all messages that are 100 KB or larger.
- **Unread Mail**: This search folder shows all messages that are unread.
- **Voice Mail**: If you are connected to an Exchange Server 2007 mailbox with unified messaging enabled, this search folder shows all received voice-mail messages.
To customize an existing search folder, open the Folder List, right-click the folder, and then choose Customize This Search Folder to open the Customize dialog box.

Set the criteria or folders to include for a search folder in the Customize dialog box.

You can change the name of the search folder in the Name box in the Customize dialog box. To change the criteria for the search folder, click the Criteria button to display a dialog box that enables you to change your selection. The dialog box that appears depends on the criteria you used when you created the folder. For example, if you are modifying a search folder that locates messages from a specific sender, Outlook 2007 displays the Select Names dialog box so that you can specify a different person (or additional people).

Note: You can change the criteria of only two of the default search folders, the Large Mail and Categorized Mail folders. The criteria for the other three can’t be changed. However, you can change the folders to be included in the search for all of the default search folders.

To change which folders are included in the search folder, click Browse in the Customize dialog box to open the Select Folder(s) dialog box. Select each folder that you want to include, or select the Personal Folders or Mailbox branch to include all folders in the mail store in the search. Select the Search Subfolders option to include in the search all subfolders for a selected folder. When you have finished selecting folders, click OK, and then click OK again to close the Customize dialog box.

Create a new Search Folder

If the default search folders don’t suit your needs, you can create your own search folder with the criteria and included subfolders that locate the messages you want. To create a search folder, right-click the Search Folders branch, and then choose New Search Folder to open the New Search Folder dialog box.

The New Search Folder dialog box provides several predefined search folders, and you can easily create a custom search folder by choosing one from the list. If the search folder you select requires specifying additional criteria, click the Choose button to open a dialog box in which you specify the criteria. Then, in the New Search Folder dialog box, select an account in the Search Mail In drop-down list to search that account.

Note: The Choose button appears in the New Search Folder dialog box only if the selected search folder requires additional configuration, such as the sender’s name.

If the predefined search folders won’t do the trick, scroll to the bottom of the Select A Search Folder list, select Create A Custom Search Folder, and then click Choose to open the Custom Search Folder dialog box to specify a custom criterion for the search folder, a search folder name, and subfolders to include.

If the default search folders don’t suit your needs, you can create your own search folder with the criteria and included subfolders that locate the messages you want. To create a search folder, right-click the Search Folders branch, and then choose New Search Folder to open the New Search Folder dialog box.

The New Search Folder dialog box provides several predefined search folders, and you can easily create a custom search folder by choosing one from the list. If the search folder you select requires specifying additional criteria, click the Choose button to open a dialog box in which you specify the criteria. Then, in the New Search Folder dialog box, select an account in the Search Mail In drop-down list to search that account.

Note: The Choose button appears in the New Search Folder dialog box only if the selected search folder requires additional configuration, such as the sender’s name.
Change the color of messages in your Inbox
When you start Microsoft Office Outlook in the morning to check your e-mail, are you looking specifically for messages sent only to you? You can easily find them at a glance by color-coding messages addressed only to you. This helps you to prioritize those messages over those you receive from distribution lists or where you are addressed on the Cc or Bcc lines of messages.

Color messages sent only to you
1) On the Tools menu, click Organize.
2) In the Ways to Organize Inbox dialog box, click Using Colors.
3) After Show messages sent only to me in, click the color that you want in the list.
4) Click Turn on.
5) Close the Ways to Organize Inbox dialog box.

Notes:
- To further customize how these messages appear, such as their font style and size, click Using Colors, and then click Automatic Formatting in the Ways to Organize Inbox dialog box.
- To turn off the color setting, click Turn off.
- To change the color, click Turn off, click the color that you want in the list, and then click Turn on.

Manage messages by using rules
A rule is an action that Microsoft Office Outlook takes automatically on an arriving or sent message that meets the conditions that you specify in the rule. You can choose many conditions and actions by using the Rules and Alerts Wizard. Rules do not operate on messages that have been read, only on those that are unread.

Rules fall into one of two general categories: organization and notification. The Rules and Alerts Wizard contains templates for the most commonly used rules.

- **Stay organized**: These are rules that help you to file and follow up on messages. For example, you can create a rule for messages from a specific sender, such as Bobby Moore, with the word "sales" in the Subject line, to be flagged for follow-up, categorized as Sales, and moved to a folder called Bobby's Sales.

- **Stay up-to-date**: These are rules that notify you in some way when you receive a particular message. For example, you can create a rule that automatically sends an alert to your mobile telephone when you receive a message from a family member.

- **Start from a blank rule**: These are rules that you create from scratch.

The Rules and Alerts Wizard contains several predefined rules, called templates.
Exceptions
You can add exceptions to your rules for special circumstances, such as when a message is flagged for follow-up action or is marked with high importance. A rule is not applied to a message if even one of the exceptions that you specify is met.

Create a rule from a template
1) In the Navigation Pane, click Mail.
2) On the Tools menu, click Rules and Alerts.
3) If you have more than one e-mail account, in the Apply changes to this folder list, select the Inbox that you want.
4) Click New Rule.
5) Under Step 1: Select a template, select the template that you want from the Stay Organized or Stay Up to Date collection of templates.
6) Under Step 2: Edit the rule description, click an underlined value.
   a) For example, if you click the people or distribution list link, the Address Book opens.
7) Under Step 1: Select condition(s), select the conditions that you want the messages to meet for the rule to apply.
8) Under Step 2: Edit the rule description, click an underlined value if you have not done so already, and then click Next.
9) Under Step 1: Select action(s), select the action that you want the rule to take when the specified conditions are met.
10) Under Step 2: Edit the rule description, click an underlined value if you have not done so already, and then click Next.
11) Under Step 1: Select exception(s), select any exceptions to the rule, and then click Next.
12) To finish creating the rule, enter a name for the rule, and then select any other options that you want.
   a) If you want to run this rule on messages that already are in one of your folders, select the Run this rule now on messages already in "folder" check box.
   b) To apply this rule to all your e-mail accounts and the Inbox associated with each account, select the Create this rule on all accounts check box.
13) Click Finish.

Create a rule from scratch
To create a rule by choosing your own conditions, actions, and exceptions, do the following:
1) In the Navigation Pane, click Mail.
2) On the Tools menu, click Rules and Alerts.
3) If you have more than one e-mail account, in the Apply changes to this folder list, select the Inbox that you want.
4) Click New Rule.
5) Under Start from a blank rule, select either Check messages when they arrive or Check messages after sending, and then click Next.
6) Under Step 1: Select condition(s), select the conditions that you want the messages to meet for the rule to apply.
7) Under **Step 2: Edit the rule description**, click an underlined value if you have not done so already, and then click **Next**.

8) Under **Step 1: Select action(s)**, select the action that you want the rule to take when the specified conditions are met.

9) Under **Step 2: Edit the rule description**, click an underlined value if you have not done so already, and then click **Next**.

10) Under **Step 1: Select exception(s)**, select any exceptions to the rule, and then click **Next**.

11) To finish creating the rule, enter a name for the rule, and then select any other options that you want.
   a) If you want to run this rule on messages that already are in one of your folders, select the **Run this rule now on messages already in "folder"** check box.
   b) To apply this rule to all your e-mail accounts and the **Inbox** associated with each account, select the **Create this rule on all accounts** check box.

12) Click **Finish**.

**Create a rule from a message**
You can create a rule directly from a message. For example, you can create a rule to move messages from someone to a specific folder.

1) Right-click the message that you want to base the rule on, and then click **Create Rule** on the shortcut menu.
   a) In the **Create Rule** dialog box, select the check boxes for the options that are already filled in with information from your selected message.

2) Select the **Move the item to folder** check box.

3) Click an existing folder or click **New** to create a new folder to store the messages.

4) To add more conditions, actions, or exceptions to the rule, click **Advanced Options**, and then follow the rest of the instructions in the Rules and Alerts Wizard.

**Tip:** To run the rule as soon as you create it, select the **Run this rule now on the messages already in folder** check box on the last page of the Rules and Alerts Wizard.

All the messages in your **Inbox**, or any folder that you choose, that meet the conditions and exceptions associated with the rule are moved to the specified folder. To test your new rule, open your new folder.

**Run a rule periodically but not all the time**
If you want to run a rule periodically but not all the time, do the following:

1) On the **Tools** menu, click **Rules and Alerts**.

2) In the **Rules and Alerts** dialog box, turn the rule off by clearing the check box next to the rule.

3) Click **Run Rules Now**.

4) In the **Run Rules Now** dialog box, under **Select rules to run**, select the check box next to the rule that you want to run.

5) Select the folder that you want to apply the rule to.

6) Select the category of messages that you want to apply the rule to.
   a) For example, you can apply the rule only to unread messages in a folder.

7) Click **Run Now**.